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Using Cumulus with Instromet stations – v0.2 

1 Introduction 

Cumulus is a well-established Windows (only) software package for handling data from automatic weather 

stations of various makes, which has now been adapted for use with the latest version of the Instromet data 

logger.  

As a program, Cumulus strikes an excellent balance between ease-of-use, an extensive feature-set and 

attractive cosmetics. In addition, Cumulus is well-supported and is free to download (though donations via the 

Cumulus website to the author, Steve Loft, who is UK-based – living in the Orkney Isles, are very welcome.) 

The main features offered by Cumulus for Instromet stations include: 

 Display of all current weather readings on a main window or ‘dashboard’ on the linked PC; 

 Support for all sensors available for the Instromet stations; 

 Retrieval of logged data from the logger when the PC may have been turned off for extended periods; 

 Maintenance of a long-term summary database of weather records as separate monthly data files; 

 Detailed climatological reporting over daily/monthly/annual periods in both text & graphic formats; 

 Automatic uploads to websites such as Weather Underground, WOW (UK Met Office) and to a 

Twitter feed; 

 Comprehensive support for running live, automatically-updating, weather websites with provision for 

both frequent and real-time update modes; 

The popularity of Cumulus with users around the world has also encouraged several third-party developers to 

write add-on templates and utilities for the program, which further extends its capabilities and overall appeal. 

The notes below introduce Cumulus and describe in outline how to install and to use it with Instromet 

stations, but for full details of the more advanced features users will need to refer to the various forms of 

online support. Cumulus provides comprehensive support for uploading live data to a weather website, but 

this is a distinct process from viewing and analysing data on the local PC and so is described in a separate 

final section. 

The Cumulus program is relatively easy to use but, as with any powerful software package, attention to 

installing correctly and time taken in familiarisation with the package will pay dividends in making the 

experience straightforward and problem-free. 

 

John G Dann 

Prodata Weather Systems 

June 2013 
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2 Preparing the Cumulus installation 

2.1 Getting ready 

Important: Cumulus is only compatible with the new model Instromet logger, introduced in 2013. It will not 

work with older versions of the logger. 

The Instromet logger has only a serial (RS232) interface and so is most easily connected to a free serial port 

on the PC. However, few laptops now possess serial ports and an increasing number of desktop PCs no longer 

have a serial port; on such PCs it will be necessary to use a serial-to-USB adapter and to connect to the PC via 

a USB port. Connect the logger to the PC before the Instromet control box is powered up. 

Where a serial port is used directly, it will need to be configured via the Port properties in Windows Device 

Manager, according to the following outline instructions: 

 How Device Manager is called up will vary with the version of Windows in use – often this requires 

calling Windows Control Panel first. If in doubt, see the online Help for your current Windows 

version; 

 Look in the Ports section of Device Manager. Where a PC has just a single serial port (and no virtual 

ports) then there should be just a single entry in this section, identified with a COM number, most 

commonly COM1. But for systems with two or more serial ports enabled, you will need to identify 

which port the Instromet logger is connected to; 

 Right-click the selected port and choose Properties and then the Port Settings tab from the dialogue 

displayed. Configure the settings as follows (if these values are not all correctly set then 

communications with the PC will not work): 

o Bits per second = 115,200 

o Data bits = 8; Parity = none; Stop bits = 1; (these are usually all default settings); 

o Flow control = none; 

The settings dialogue should look like this: 

 

If a serial-to-USB adapter is in use then similar settings will still need to be made and checked, but the 

procedure will vary according to how the particular USB adapter is managed via its driver. Often this will be 

exactly the same process within Device Manager as described above, but for the virtual COM port created by 

the USB adapter’s driver. 
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2.2 Downloading and Installing Cumulus 

Cumulus requires Windows XP or later (i.e. Vista, Windows 7 or Windows 8) and is compatible with both 32 

and 64 bit versions of these operating systems. (NB The drivers for any serial-to-USB adapter in use 

obviously also need compatibility with the PC’s Windows version.) 

Cumulus is available only by (free) download from its parent website. The latest ‘Stable release’ version may 

be downloaded from http://sandaysoft.com/downloads .  (NB Links to beta test versions of the latest 

development version of Cumulus will also often be found on this same download page or as posted in the 

Announcement section of the main Cumulus forum, but are not recommended for installation by users new to 

the program.) 

Cumulus is updated frequently. At the time of writing, the latest version of Cumulus is v1.9.4 (Build 1080), 

but this will doubtless be superseded before long – simply use the latest available version. 

Temporary Note: The Instromet-compatible v1.9.4 version of Cumulus is currently (May 2013) and officially still in beta. For the 

time being therefore, this needs to be downloaded from http://www.nybbles.co.uk/downloads/beta194/CumulusSetup.exe (as per the 

forum link). 

Installation is simply a matter of running the main CumulusSetup.exe executable and following the onscreen 

prompts. It is strongly recommended that the program is installed into a C:\Cumulus folder and not elsewhere. 

For future reference, updating to a new version of Cumulus is very straightforward: simply download the new 

version and install it. This overwrites existing program files (but not existing data files) with their new 

versions. There is no need to uninstall the old version prior to updating. The current version and build number 

may be found from Help | About, as usual for Windows programs. (The same version number is often released 

with successive build numbers as minor bugs are fixed.) 

2.3 Help for Cumulus 

These notes provide a short initial guide to using Cumulus, but much more information is available from 

additional online sources. Cumulus is an easy program to set up and if you’re only interested in using its basic 

features then you may never need to resort to further help. But for those looking to use the more advanced 

features in Cumulus then there’s plenty of additional information on offer from these further sources: 

 The main Help menu inside Cumulus, which provides detailed advice on the various configuration 

settings, in particular. It’s well worth acquainting yourself with this option even if you look at no 

other source of help. As usual with Windows programs, Help is the last item on the main menu bar 

and is the gateway to the Help pages as a whole. In addition, most dialogues have a separate Help 

button which will take you to specific Help for that particular dialogue; 

 The file readme.txt will be found in the main Cumulus installation folder and provides an overview of 

installation and use, plus any late-breaking information; 

 A PDF file downloadable from  

http://sandaysoft.com/download/Cumulus%20basic%20installation%20guide.pdf  also provides a 

basic installation guide similar to the readme.txt file; 

 There is a Cumulus FAQ at: http://wiki.sandaysoft.com/index.php?title=FAQ; 

 And a wiki at: http://wiki.sandaysoft.com/ .(This wiki is a work in progress and predominantly has 

information on more advanced aspects of Cumulus.) 

 Last, but absolutely not least, there is a friendly and helpful online forum, including frequent answers 

from Steve (the author of Cumulus), which new users are welcome to browse and seek support at: 

http://sandaysoft.com/forum/ .  

  

http://sandaysoft.com/downloads
http://www.nybbles.co.uk/downloads/beta194/CumulusSetup.exe
http://sandaysoft.com/download/Cumulus%20basic%20installation%20guide.pdf
http://wiki.sandaysoft.com/index.php?title=FAQ
http://wiki.sandaysoft.com/
http://sandaysoft.com/forum/


06 June 2013 4 v0.2 

3 Getting started with Cumulus 

3.1 First steps 

The notes below assume that the initial set-up has all been completed successfully, as described above, i.e. 

that: 

 The Instromet sensors and control box are all cabled up and connected to the PC (with the control box 

not having been powered up until after connection to the PC); 

 If a serial-to-USB adapter is being used, that the correct driver for this has been successfully installed; 

 The Cumulus program has been correctly installed;  

Cumulus is started by clicking its Start Button menu entry, desktop icon or (Windows 8) tile, i.e. much the 

same as any other standard Windows program, and the Cumulus window should then appear. The main 

window presents a ‘dashboard’ of information and current weather readings and with a conventional main 

menu bar providing access to various settings and reports.  

To start seeing live readings from an Instromet station, two initial configuration steps are needed (in addition 

to setting up the serial port correctly – or virtual serial port in the case of a USB adapter – as noted above). 

These are located on the ‘Station’ configuration screen accessed from the main Configuration menu of 

Cumulus: 

 Set the Station Type to ‘Instromet’ (top left configuration panel); 

 Set the Serial Port to the appropriate COM port number (top right configuration panel); 

There are a number of other settings that you may wish to alter in due course (see below), but these two are 

the two key settings to make to get the station reporting live data to the PC. If the live readings do not appear 

then you may need to close and then reopen Cumulus or, if unsuccessful, try rebooting the PC. (If the live 

readings still do not appear then very possibly the serial port COM number has been set incorrectly.) 

The best way of learning about Cumulus in more detail is to read the online Help within the program (i.e. as 

accessed from the Help menu). In particular, the section ‘The Displays | The Main Window’ provides an 

introduction to the main window of Cumulus; and the section ‘Configuration | Configuration: Station’ runs 

through all the configuration option on the main configuration screen.  

Do remember that Cumulus is intended for use with a number of different makes of weather station and 

several of the configuration options will not be relevant to use with Instromet stations. 

3.2 Configuring Cumulus 

Cumulus main screens 

The main window of Cumulus (see the second screenshot further below) serves two functions: 

First, it is the ‘dashboard’ or ‘home page’ of Cumulus, appearing when Cumulus is started and acting as the 

central screen from which all other data views and functions can be accessed via the various menu options. 

Whatever additional views and configuration options you call up in Cumulus, you will always return to this 

primary screen.  

Second, it provides a live readout of current weather readings, including graphical presentation of wind speed 

and direction data, and a few key weather statistics. 

Several additional display and configuration screens are also available, which are called up from the main 

menu options of the primary window, with the ‘Configuration’ and ‘View’ top-level menus being the two 

menus which will be most used. 

The main configuration screen (entitled ‘Station Settings’) is accessed from the Configuration | Station 

menu option and contains many of the configuration settings for Cumulus that control how it receives, stores 

and displays weather data on the local PC. 

The Internet Settings screen (Configuration | Internet menu) provides all the configuration options for 

running a live weather website, but this section is best left until Cumulus has been fully configured locally. 
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The Display Settings screen (Configuration | Display) controls certain settings that mostly affect details of the 

on-screen displays. There are only a couple of settings on this screen that are relevant to initial use with 

Instromet stations. There’s a brief introduction to the Display Settings screen further below. 

(There are various other menu options on the main configuration menu (Colours, Calibration etc) but these 

can be investigated at a later date – none is critical to initial setting up.) 

Configuring Instromet sensors 

The following Instromet sensors can all be read from the Cumulus screens: 

 Air temperature; 

 **Second temperature or wet bulb temperature; 

 **Humitter (humidity); 

 Wind speed and direction; 

 Barometric pressure; 

 Rainfall; 

 Sunshine hours; 

Sensors which are not fitted will simply be ignored and their readings will be zero or blank. 

**There are special rules that define how Cumulus behaves with these second temperature and/or humitter 

sensors:  

(a) If a humitter sensor is present then this will be used as the source of humidity data and for the 

calculation of dew point temperature values. If a second temperature sensor is fitted in addition to the 

humitter, then the Extra Sensors option on the main Station Settings screen needs to be ticked. The 

reading from the second temp sensor will then appear in the optional Solar/Extra panel (see note 

below). 

(b) If a humitter sensor is not fitted, but a second temperature sensor is present then there is a choice of 

two configurations: 

 If the second temperature sensor is the wet bulb sensor then Cumulus should automatically 

treat it as such and calculate humidity etc from this temperature reading. (The Extra Sensors 

option should then not be ticked.); 

 If the second sensor is simply a second independent temperature sensor then the Extra 

Sensors settings needs to be ticked as noted above; 

Where Temp #2 is being used as a wet bulb sensor then a Dew Point temperature will be calculated and 

displayed. Hovering over the Dew Point reading should show the actual wet bulb temperature being read. 

Where there is no humidity sensor (i.e. neither wet-bulb nor humitter) then the Apparent Temperature reading 

on the Cumulus display will not read sensibly. Please ignore the App Temp reading in these circumstances. 

Note also that the Instromet sun sensor is a sunshine hours sensor and not a solar irradiance sensor. (Most 

Cumulus stations read irradiance values and not sunshine hours and so Cumulus caters for both sensor types – 

be careful not to confuse the two.)  But provided you have selected Instromet as the station type then sunshine 

hours readings, both for today and yesterday, will appear in the optional Solar/Extra panel which can display 

at the bottom of the main dashboard window.  This panel will be displayed when the 

Configuration | Display | Display Solar/Extra Data option is checked. 

Suggested Station Settings 

Cumulus offers a substantial number of optional settings that are controlled by the Configuration | Station 

menu option – see screenshot below.  

This settings screen may initially appears a little complex, but in practice, there are only a few important 

settings – standard sensor readings will still appear correctly irrespective of other settings, which can be 

reviewed in more detail as and when time allows. And the options are reasonably self-explanatory and logical. 
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Also, several of these settings are a personal choice, which new users should decide on for themselves – 

consult the online Help if the meaning is not immediately obvious. 

 

But here are some brief comments/suggestions on some of the more important settings (setting blocks not 

specifically mentioned are either fairly unimportant or simply irrelevant to Instromet stations): 

 ‘Station Type’ obviously needs to be ‘Instromet’; 

 ‘Serial Port’ (top right) must be correctly set, otherwise Cumulus cannot receive data of course; 

 In the ‘Settings’ block: 

o Check ‘Calculate 10 min wind average’ (Instromet stations don’t do this themselves); 

o IF (and only if) a humitter or wet bulb sensor is fitted then check ‘Calculate dew point’; 

o Check ‘Calculate wind chill’; 

o Check ‘Synchronise station clock’; 

o Check ‘Use data logger’ (Important, otherwise logged readings won’t be read); 

o IF (and only if) a second temperature sensor is fitted and it’s not being used as a wet bulb 

sensor then check ‘Extra Sensors’; 

 In the ‘Location’ block, enter a reasonably accurate latitude and longitude (this is essential to getting 

reliable sunrise/sunset etc times). The Name and description appear primarily on web pages; 

 ‘Units’ block (Important): These are the units in which you wish to see readings displayed. They are 

also the units used when saving data to the disk files. Think carefully about your preferences before 

you start to use Cumulus seriously – if you change your mind on units later then your data files will 

have a confusing mixture of stored units; 

 ‘Logs roll over at’ – this is the setting to use if you wish the station day (for high/low records and e.g. 

rainfall amounts) to start at 0900 (and optionally 0900GMT in summer time too, with the associated 

‘9am rollover’ setting) rather than the default midnight to midnight records; 
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 ‘Data log interval’ (Important): This setting provides the mechanism to change the data logger 

interval. If changed, it’s recommended that you close and then restart Cumulus to ensure that the 

change has been transmitted to the logger; 

 ‘Forecast’ block: Checking ‘Cumulus Forecast’ will prompt Cumulus to generate a simple Zambretti 

forecast automatically for the next few hours ahead. NB This requires a few hours data and may show 

as ‘Not available’ when first enabled; 

Weather readings in the main window 

This area of the main Cumulus window mostly shows current weather readings and should be largely self-

explanatory.  

The top section shows various astronomical data such as sunrise/sunset times along with the forecast text, if 

available. The title text in this section (‘My Weather’ by default) can be edited in the Display Settings 

dialogue (see below). 

Then the various individual panels show current readings for the main weather parameters – temperature, 

wind, rainfall etc – together with extremes for today so far and also for yesterday. Obviously it can take up to 

24 hours for all of the available readings to be populated. If a particular sensor is not fitted then the reading for 

that sensor will show as zero or blank. If a second temperature or a sunshine hours sensor is fitted then the 

optional Solar/Extra panel needs to be enabled as described in the ‘Configuring Instromet sensors’ section 

above. 

The status panel: This panel shows three LED-type indicators, which flash when particular events happen. If 

enabled, the ‘New Record’ LED flashes when a new all-time record has just been set. (With a new installation 

this may happen quite frequently to start with.) And the ‘Error’ LED flashes when a significant error has 

occurred, which won’t necessarily be serious – it could be just a one-off error for instance with an upload to a 

website. In either case, clicking on the flashing LED will provide further information about the event, 

including an option to ‘clear’ the flashing LED. 
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The area to the right of the main window has graphic dials to show live wind data, specifically: current wind 

gust and average speeds, wind direction and, on the bottom dial, a representation of speed-weighted wind 

direction over the past few hours. 

The status bar at the bottom of the window displays various status messages such as when web uploads are 

taking place, but will also show – on the right of the bar – the status when stored data is being downloaded 

from the logger (i.e. after a period when either Cumulus or the PC as a whole has been switched off. 

Display Settings 

This settings dialogue manages the detail of some of the panels you see on the main Cumulus screen and 

elsewhere, and is accessed from the Configuration | Display menu option. None of these settings is critical and 

can be reviewed as and when convenient in consultation with the online Help. But there are two specific 

Display settings that new users may wish to amend: 

 The Heading text can be customised to your own station’s name or other preference; 

 If you have a sunshine hours sensor or are using Temp #2 as a second temperature sensor (i.e. and not 

as a wet bulb sensor) then ‘Display Solar/Extra data’ needs to be checked to ensure that the optional 

data panel does show up on the main dashboard screen; 

Using the data logger 

To connect an Instromet station to a PC at all, you obviously must have a data logger. This logger is able to 

operate in two separate modes, passing either live data or stored data to the PC. When Cumulus is running 

normally on the PC then Cumulus will be using the feed of live data and requesting new data every second.  

But when Cumulus is not running or the PC is simply switched off then the logger will be storing summary 

data at preset intervals. This stored data will continue to accumulate in the logger for an extended period (up 

to the capacity of the logger – see logger documentation for details). When Cumulus restarts it will 

automatically download stored data first, process this data (for highs and lows etc) and then save the data to its 

long-term monthly database files. Depending on the amount of stored data, this download can take a minute or 

two to happen – a progress bar will be shown onscreen. Once the download process is complete then Cumulus 

will revert to using the per-second feed of live weather data. 

The data stored in the Cumulus monthly database files is also stored at preset intervals as controlled by the 

‘Data log interval’ panel on the ‘Station Settings’ configuration dialogue. The interval can be chosen from a 

range of times between 1 and 30 minutes, but 10 minutes is often a good and recommended choice – it 

provides decent detail throughout the day but without resulting in a large volume of largely redundant data. 

Note that the data intervals on Cumulus and on the Instromet logger are independent settings, but Cumulus 

will work best if these two values are the same. So Cumulus is designed such that each time it starts up it also 

resets the Instromet logger interval to the same as its internal data interval. In the normal course of events it 

will be very rare that, once initially set, the interval ever needs to be changed. But if the interval ever is 

changed then it will be good practice to close Cumulus and then reopen it, just to ensure that the Cumulus and 

logger intervals are synchronised. 

Alarms 

We should also mention that Cumulus does possess an Alarms feature. In other words, threshold values for 

various weather parameters can be set above or below which an alarm condition is triggered and which can be 

set to give a visual or audible warning. For example, a frost alert could be sounded if the air temperature falls 

below 3°C or, similarly, a high wind speed warning. Alarms are controlled from the Edit menu of Cumulus – 

please consult the online Help for further information. 

Final configuration comments 

The notes above should provide sufficient detail for new users to get Cumulus up and running with Instromet 

stations, but final tweaking can obviously be done with reference to the further sources of Help and support 

that are available. 
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The two remaining sections of notes below provide information first on the data analyses and reports that 

Cumulus provides on the local PC, and then, secondly, a section that introduces the various website features 

that are available. 
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4 Local viewing and reporting features in Cumulus 

4.1 Introduction 

Cumulus offers a number of ways to analyse and view your data on the local PC, in addition to the current 

readings dashboard of the main window described above. (‘Local’ meaning what is possible to view on the PC 

directly connected to the weather station. Features and data presentations available on uploaded webpages can 

be very different and so are described in a separate section.)  

Note that there is some overlap between local and website usage even if you don’t plan to run your own full 

weather website. For instance, you may run predominantly locally, but still wish to upload data regularly to 

say the websites at Weather Underground or to the UK Met Office’s WOW system. And conversely it is 

possible, for example, to make good use of certain of the website features across a local area network. So for a 

full picture of what Cumulus can offer, it’s a good idea to become familiar with both local and website aspects 

of the program. To keep things simple, however, the focus in this section is solely on local data views, with all 

website-related features described in the separate next main section. 

The various Cumulus views/reports are all available from the main View menu. To a large extent, these 

views and reports are self-explanatory – take a look at the various options and you’ll quickly see what they 

offer – so we’ll just briefly list the different types of data views etc that are available. But remember that many 

of these reports look back on the whole body of historical weather data that you have accumulated, so in the 

first day or two of operation there won’t be too much of interest to review! 

There are four main types of view or report that can be called up, which are summarised below, but in a 

somewhat different order – for ease of explanation – to that appearing on the Cumulus View main menu. 

(There are a couple of further view types but these are less useful and can be researched via the online Help.) 

4.2 Statistical reports 

These are reports that calculate and display various statistical indices of past weather such as averages, totals, 

highs and lows over specific time periods. There are many ways of analysing your accumulated data to 

generate such reports and Cumulus offers three distinct options: 

Climatic reports over e.g. monthly and yearly periods 

These reports are generated by the menu options called ‘This month’; ‘This year’ and ‘This period’ on the 

main View menu. For the first two options, the user specifies which particular calendar month or year is to be 

analysed, whereas for ‘This period’ the user enters start and end dates and so the report can cover any 

arbitrary period for which data is available. On clicking the ‘Update display’ button in the dialogue window 

which appears then Cumulus will analyse the log files for the particular month or year or arbitrary period and 

display a full set of summary values for the main weather parameters (temperature, rainfall, wind speed, 

pressure etc). The data in the onscreen report can be copied to the clipboard for pasting into another program 

for further formatting, printing etc, as required. 

NOAA reports 

These reports – which are available just as monthly or yearly options – serve a similar summary purpose to the 

‘This month’ etc reports just described, but are in a different and particular format as prescribed by NOAA 

(the US Met Office) and which has become something of a universal standard for this type of report. The 

NOAA reports also differ from the standard Cumulus reports in showing a day-by-day (monthly report) or 

month-by-month (yearly) summary of weather for that period, in addition to overall monthly or yearly 

summary values. The Cumulus standard and the NOAA reports are therefore both useful in different ways and 

are largely complementary to one another. 

All-time extremes and related reports 

These are reports viewed from the set of View | Highs and Lows menu option and list a complete set of 

extreme values (e.g. maximum high or minimum low temperature) observed for all weather readings over a 

defined period of time.  
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The emphasis of these extremes reports is on providing the exact date and time of occurrence of high and low 

readings for all of the main weather parameters. In contrast, the ‘This month’; ‘This year’ and ‘This period’ 

climatic reports described in the first section above focus on a giving a statistical picture of the period and do 

include mean values across the period for various parameters (which the Highs and Lows reports do not), but 

with less detail on the extremes. The extra detail in the extremes reports is reflected in the fact that there are 

separate tabs in the window for temperature, wind, rainfall, humidity and pressure readings so that all of the 

extremes information can be neatly presented, whereas the climatic reports can be adequately presented in a 

single window. 

There are actually six different reports of this type available: All-time; Monthly; Today; Yesterday; This 

month; and This year. The most obvious of these is the All-time extremes report which shows the highest and 

lowest readings ever measured by your weather station since Cumulus logging started. The other five ‘Highs 

and Lows’ reports cover the periods referred to in their menu names.  

The Today (so far, of course) and Yesterday reports should also be obvious enough as a way of reviewing 

weather highs and lows over the last 48 hours or so. Monthly allows the user to select a calendar month for 

analysis (e.g. is this the wettest July or coldest January on record) – clearly this option becomes much more 

powerful once several years’ worth of data has accumulated. Then This month provides a a single summary of 

highs and lows so far this calendar month, while This year offers a similar function for the current calendar 

year. 

As with other Cumulus reporting tools, the simplest way of understanding the function of these reports is just 

to take a look at a few of them (again these will make more sense once at least a few days’ worth of data has 

accumulated). 

The reason for the apparent overlap in function of certain of the reports seems to be that the data files which keep the long-term 

extremes records are only updated at intervals, whereas of course a new period extreme may only just have happened. So there is a set 

of very recent extremes data help in memory which has yet to be written to disk. Some of the shorter-term extremes reports like Today 

and Yesterday will source their data from the recent data store rather than the long-term ones (or from a mixture of the two), hence the 

need for the apparently overlapping report types. 

4.3 Graphs 

Cumulus provides two distinct charting options on the View menu: ‘Graphs’ and ‘Select-a-Graph’, which 

serve different purposes as described in more detail below. (NB We’re using the terms graphs and charts 

interchangeably):  

Graphs 

This option generates a set of dual-purpose graphs, which are (largely) fixed-format and created 

automatically. The graphs can be viewed locally and, optionally, can also be uploaded to your website (if you 

have this feature set up). 

These charts can be viewed using the View | Graphs menu option, which calls up a window showing one 

larger chart at the top with thirteen thumbnail charts beneath. Clicking on one of the thumbnails replaces the 

current large chart by the type of the new thumbnail.  

Eight of the charts have a short-term timescale (default is 12 hours), while the remaining five are intended to 

provide a picture over a longer period of 31 days, by default. (A few of the graph features, including the hours 

and days covered by the two types of graph, can be changed either by using the ‘Graphs’ section of the 

Configuration | Display menu option or by right-clicking on the larger top chart.) But, broadly, the type, 

number and appearance of the charts is fixed. The exact nature and configurability of the graphs can easily be 

seen by the user once a few days’ worth of data has been collected. 

Exactly this same layout of charts can also, optionally, be uploaded to a website and whatever local editing of 

the chart configurations may have been carried out locally will also be reflected in the website uploads. 

Select-a-Graph 

This graph option displays just a single chart but allows the user full control over which weather parameters 

are plotted and over which time period. The weather parameters can be selected from the list of 19 primary 

parameters (though not all will be available on an Instromet station – it’s obviously dependent on which 
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sensors are fitted to the station) and the timespan can be varied, for example, from hours to many months 

(only limited by the available data). It is also possible to superimpose multiple weather parameters on the 

same chart. 

This option is a very powerful and flexible way of visualising past weather data on the local PC. It is largely 

self-explanatory – the best advice is simply to experiment with this feature (perhaps once you have 

accumulated at least a few days’ worth of data to review).  

Select-a-Graph in intended primarily for local use only – there’s no associated automatic website upload 

option. However, the File submenu in the graph window does offer a ‘Save’ option, which will save the 

current graph to a standard image file (PNG format) at a resolution of 600x300px. Such files could obviously 

be uploaded manually to a website, if required. 

4.4 Database File Viewers 

Selecting View | Data Logs will launch the Data Log Viewer, which displays the full set of logged data for an 

individual month in a spreadsheet-like format. When the Viewer first launches, the display is blank – you 

must first click the ‘Load’ button and browse to an individual month’s data, choosing one of the files in the 

MmmYYlog.txt format such as Apr13log.txt. Note that the Viewer is just a viewer and not an editor – its 

purpose is to allow the user to look in detail through the entirety of the logged data for a given month, but not 

to make any changes (it’s safer that way). Any editing of the log files will need to be done outside the viewer. 

‘Extra data’ and extra sensors 

Two of the options on the View menu relate to so-called ‘Extra data’. These pertain to sensors beyond the standard complement for a 

weather station and whose readings are not stored by Cumulus in the main log files but in the set of ExtraLog files. The current 

readings from these extra sensors are not usually presented on the main Cumulus dashboard but on a supplementary dashboard viewed 

with the View | Extra data menu option. 

This ‘extra data’ feature is not generally relevant to Instromet stations, but there is one small exception. If a Temp #2 sensor is fitted 

and it’s not being used as a wet bulb sensor then the readings from the sensor are stored (as the only non-zero entry) in the monthly 

ExtraLog files. However, because there is only one extra reading possible on the Instromet station, this reading has been fitted in on 

the main dashboard (in the optional Solar/Extra panel) and do not appear on the supplementary ‘Extra data’ dashboard. But to see the 

stored log readings for Temp #2 it will be necessary to use the relevant viewer, i.e. as displayed by the View | Extra data logs menu 

option. 

4.5 Editing data 

Even with the best weather stations, there are occasions – perhaps when setting up or servicing sensors, if not 

actual faults – when spurious values may get recorded in the various Cumulus data files. Cumulus provides 

extensive facilities for editing or correcting any such values, which are accessed via the main Edit menu. It’s 

beyond the scope of these introductory notes to go into detail of which files to edit to correct different types of 

error, but the main online Help is the place to look for further assistance (or, failing that, ask on the Cumulus 

support forum). 
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5 Website Uploads from Cumulus 

5.1 Overview 

Cumulus offers a number of ways in which live weather data can be uploaded to a website, thereby allowing 

your data to be viewed by anyone worldwide with Internet access and who knows the web address. The web 

uploads methods fall into two main categories: 

 Uploads to an account at a third-party website such as Weather Underground or WOW; 

 Uploads to your own custom weather website; 

The second of these options – uploads to a custom website – is ultimately much more flexible and more 

powerful and so the bulk of the notes below are devoted to this approach. But uploads to a third-party website 

are typically much easier to set up and offer the simplest approach to making your weather data available 

online. 

The majority of settings that control website uploads for both upload categories will be found in the Internet 

Settings dialogue, which is accessed from the Configuration | Internet main menu option. 

 

This is obviously a dialogue with quite a number of settings options but, once again, the options are laid out 

quite logically and if you’re only looking to upload data to one single site then only one small section of the 

settings will need to be correctly completed. This is really a question of deciding which particular upload 

function you wish to use and then focusing on that particular section – in general, the rest of the settings can 

be ignored. 

Overall, Cumulus does make it relatively easy to upload weather data to websites – don’t be put off by the 

number of different settings that you can control in principle, but do make sure that any setting you do wish to 
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use is exactly correct (websites can be very unforgiving if for example you’ve used a capital letter when it 

should be lower case). 

5.2 Uploads to third-party websites and weather communities 

Third-party websites are services such as Weather Underground where the whole structure and layout of the 

website and all its constituent pages are managed by the owners of the site. All you need to do to set up data 

uploads to such sites is to register an account at the site and thereby to obtain a username and password. Then 

entering these credentials into the appropriate section of the Cumulus Internet Settings will cause your data to 

be uploaded automatically and at regular intervals to the site in question. Your data will then be displayed on 

your own account page on the website and will be visible to the world. Each third-party website of this type 

has its own data format requirements, but Cumulus already knows all about these format and will serve the 

appropriate format to the particular website. 

By joining one or more of these community weather networks, you are becoming a community member 

contributing to and sharing your data with typically many thousands of other such users worldwide. It’s 

usually free to join these communities and to upload data, which is another benefit of this type of upload. 

Cumulus currently supports uploads to five of these third-party weather networks: 

 Weather Underground 

 WOW 

 APRS/CWOP 

 PWS 

 Weatherbug 

Of these, Weather Underground is by far the best known. It collects data from over 25,000 weather stations 

around the world and can store your data long-term and present the live data on a worldwide map. Weather 

Underground offers many features – start exploring the site at: 

www.wunderground.com/weatherstation/about.asp . 

WOW is a relatively new service which is run by the UK Met Office. For UK residents, if you’ve always 

wanted to be able to submit your live weather data to the Met Office then WOW provides a gateway to do just 

this. For further information, see: wow.metoffice.gov.uk/ . 

The other three services – APRS/CWOP, PWS and Weatherbug – are more US-orientated, though each 

welcomes data submissions from around the world. 

The features available vary from network to network. But all of them support data uploads at regular intervals 

(e.g. every 15 mins) and most also support a catch-up feature, i.e. if your PC has been switched off for a 

period (but the data logger has continued logging) then the backlog of data will be transmitted to the relevant 

weather network once the PC is switched back on. And some services support special features. For example, 

Weather Underground has a feature called RapidFire where rapidly-changing data such as wind data can be 

uploaded as often as every 5 seconds. Cumulus does support RapidFire (provided this feature is enabled, i.e. a 

check placed in the RapidFire checkbox of the Weather Underground settings panel). 

So to start uploading to a particular weather network community, you need do only two things: 

1. Visit the relevant community website and register an account, noting e.g. username and password; 

2. Enter these details into the relevant section of the Cumulus Internet Settings dialogue, make sure that 

you check ‘Enabled’ for that particular upload destination and also enter any additional optional 

settings; 

Restart Cumulus and within a short time, your readings should start appearing on the community website in 

question. 

http://www.wunderground.com/
http://www.wunderground.com/weatherstation/about.asp
http://wow.metoffice.gov.uk/
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5.3 Uploads to your own website 

5.3.1 Introduction 

This section describes how to use Cumulus to upload live weather data to your own area of webspace. This is 

the approach to use if you want a comprehensive and fully detailed weather website with the potential to 

customise fully to your own requirements. It isn’t necessarily difficult to run a basic weather site – Cumulus 

offers various templates to get you up and running fairly easily – but of course if instead you’re aiming for a 

more customised site it will take some time and expertise to develop a highly sophisticated set of webpages.  

Running your own website assumes that you already possess some suitable webspace along with all the 

necessary credentials with which to upload data. If you don’t already have the webspace then you’ll need to 

acquire some – it’s outside the scope of these notes to describe what to do in detail, but it’s possible that your 

ISP plan includes some free webspace already or, failing that, commercial webspace is available at relatively 

low cost, e.g. £30-50 a year. (It’s usually well worth paying a modest amount for webspace – while there is 

so-called ‘free’ space on offer, it’s typically of poor performance or loaded with adverts. So if you get to the 

point of wanting to run your own website then you’ll possibly need to accept a small annual price-tag for 

doing so.) 

There’s more detail below about using the credentials that you’ll need to upload data to your webspace, but 

typically you’ll need four pieces of information: 

 Host name: Essentially, this is the web address of the server to which the uploads will be sent (but 

usually this won’t be exactly the same as URL that you then use to view the data on the web); 

 Username: A specific account name that allows you to upload to the web server; 

 Password: The password for the account; 

 Directory: A specific folder on the web server to which your uploads should be directed. You should 

be told which folder to use in the documentation that comes with your webspace plan; 

The exact details here, especially of Host name and Directory, can vary significantly between different 

webspace providers – this is why it’s important to keep the provider’s instructions and documentation to hand. 

Cumulus offers several approaches to creating your own weather website ranging from the straightforward to 

much more sophisticated options requiring some knowledge of webpage design. We can do no more than to 

comment on the main options here and the next three sections outline those options. (Bear in mind also that 

web page design can be very flexible and so it’s perfectly possible – given a degree of design expertise – to 

mix and match elements from different approaches.)  

5.3.2 Cumulus templates 

The simplest approach to creating your own weather website is to use the webpage templates automatically 

installed along with other Cumulus files.  

Setting up a standard Cumulus website is easy! You can get a complete weather-reporting website – as 

described in more detail below – up and running relatively simply. All you need is some webspace; to upload 

a few starter files by FTP to the space; and to make a few appropriate settings in the Configuration | Internet 

section of Cumulus. The procedure is described in detail in the Cumulus wiki at 

wiki.sandaysoft.com/a/Simple_Website_setup . (NB If you don’t already have an FTP client, then we suggest 

using Filezilla Client, which is a free download from https://filezilla-project.org/ .) 

The standard Cumulus website uses a set of nine template pages that will set up a website of nine distinct 

webpages covering different types of weather data content as listed here (and with example links to the 

specific page on the Sanday weather website): 

 A current weather conditions page (which would be your home page) - www.sanday.org.uk/weather/; 

 Current conditions with gauge readouts - www.sanday.org.uk/weather/gauges.htm; 

 Highs and Lows readings for Today - www.sanday.org.uk/weather/today.htm 

 Highs and Lows readings for Yesterday - www.sanday.org.uk/weather/yesterday.htm 

 Highs and Lows readings for This Month - www.sanday.org.uk/weather/thismonth.htm 

 Highs and Lows readings for This Year - www.sanday.org.uk/weather/thisyear.htm 

http://wiki.sandaysoft.com/a/Simple_Website_setup
https://filezilla-project.org/
http://www.sanday.org.uk/weather/
http://www.sanday.org.uk/weather/gauges.htm
http://www.sanday.org.uk/weather/today.htm
http://www.sanday.org.uk/weather/yesterday.htm
http://www.sanday.org.uk/weather/thismonth.htm
http://www.sanday.org.uk/weather/thisyear.htm
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 All-time Highs and Lows record readings - www.sanday.org.uk/weather/record.htm 

 Record Highs and Lows by calendar month - www.sanday.org.uk/weather/monthlyrecord.htm 

 Trends – a set of graphs showing recent weather trends - www.sanday.org.uk/weather/trends.htm 

We suggest you review the example site – this will give you a good idea of how the standard site looks and 

how it’s structured. If you start from the home page, you’ll see a menu of links at the bottom of the main data 

block which will take you through to the other pages of the site and in the order listed above. (NB Some of the 

text on this site is very slightly altered from the default, but the differences are small.) 

You’ll probably notice a couple of things about this site. First, the pages fall into one of four types: 

1. The home or current conditions page, which provides a quick snapshot of current weather readings; 

2. The gauges page which gives a visual graphic indication of current weather conditions (see further 

comment below); 

3. A ‘Trends’ page containing charts which show graphical trends in weather over recent hours and 

days; 

4. A set of highs and lows values for six different time periods; 

Second, apart from the first ‘current conditions’ page and the gauges page, all of the other seven pages should 

be very familiar from Cumulus running on the local PC. The Highs and Lows data is all very similar to that 

available from the various Extremes options on the View menu. (Of course, the data is reformatted somewhat 

so as to render correctly on an HTML webpage rather than on a local Windows Form, but the origin and 

general layout of the data should be very clear.) And the ‘Trends’ page is essentially identical to that available 

from the View | Graphs men option in the local PC Cumulus program – indeed any changes made to the local 

version of Graphs will also be reflected in the version uploaded to the website. 

The ‘Gauges’ page merits more comment. The standard Cumulus gauges page consists of fourteen graphic 

elements that depict different weather readings in graphic form. Nine of these are linear thermometer-type 

graphic presentations, while the five at the bottom are dial-type representations, for weather parameters such 

as wind direction and wind speed that can be seen more clearly on a circular dial. Hovering the mouse over 

any one of these gauges shows a small pop-up panel that provides further detail about the reading. 

At the bottom of the gauges page you will also see two further gauges, one for wind speed and one for wind 

direction and labelled ‘Real-time wind data’. These are different in kind from all the other gauges above. 

Whereas the main set of gauges typically update at an interval of several minutes (user-defined, but typically 

every 5-15 minutes) and require the page to be manually refreshed to see new data, the two real-time gauges 

update automatically and read their data from a small text file (called realtime.txt), which is uploaded much 

more frequently, for instance every 5 seconds. (This real-time feature does need to be turned on in the ‘Web 

Settings’ panel of the Configuration | Internet dialogue, but this is simple to do.) The result is that the real-

time dials flick with the varying wind speed and direction every few seconds and give a realistic impression of 

a display that is linked directly to the weather station. 

The gauges page is also one that can be replaced by other related gauge displays but with a very different and 

arguably superior appearance. This is a somewhat more advanced topic, but not especially difficult to do. Two 

such options are: 

 The Cumulus Silverlight real-time gauges – see www.sanday.org.uk/weather/realtime.htm for an 

example and see the wiki at wiki.sandaysoft.com/a/CumulusRealtime for details of how to implement; 

 The Steelseries gauges – see www.sanday.org.uk/weather/gauges-ss.htm as an example. This is 

probably the most impressive gauges page, the more so if you hover the mouse over certain of the 

dials and see attractive trend graphs and further weather details appear. Once again, details of how to 

implement this page are in the wiki at wiki.sandaysoft.com/a/SteelSeries_Gauges . NB Using these 

SteelSeries gauges is a somewhat more advanced topic, but even so is not difficult to get working; 

Just to add a brief word on how the templates work (there’s a little more detail available, again in the wiki, at 

wiki.sandaysoft.com/a/Customised_templates ): 

Each of the nine webpages that is part of a standard Cumulus website starts life as a template file stored on the 

local PC. These template files are named similarly to the webpage that they become but with a capital ‘T’ at 

http://www.sanday.org.uk/weather/record.htm
http://www.sanday.org.uk/weather/monthlyrecord.htm
http://www.sanday.org.uk/weather/trends.htm
http://www.sanday.org.uk/weather/realtime.htm
http://wiki.sandaysoft.com/a/CumulusRealtime
http://www.sanday.org.uk/weather/gauges-ss.htm
http://wiki.sandaysoft.com/a/SteelSeries_Gauges
http://wiki.sandaysoft.com/a/Customised_templates
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the end of the main part of the filename, thus the webpage called today.htm is created from the template file 

called todayT.htm. The live weather content is represented in the template file in one of two ways: 

 For text values, such as current temperature or pressure there is a placeholder string or webtag in a 

special format placed in the template file at the position where the text value is to appear; 

 For image data, as in the trends.htm webpage, there is a link in the webpage to a specific graphic 

image file of known pixel size; 

Then, at the regular scheduled upload interval (e.g. every 15 minutes), Cumulus processes the template file 

and replaces all the webtags with their current weather reading values and uploads the resulting files (omitting 

the capital T from the file name) by FTP to the web server, along with newly generated image files. The result 

is that every 15 minutes (or whatever the upload interval) the website pages and weather images are 

regenerated to contain all of the latest weather readings. 

5.3.3 Customised templates 

It is possible to write your own templates completely from scratch if the templates do not generate web pages 

exactly to your liking, but this is an advanced topic, introduced briefly in the section below. However, it is 

much simpler to make modifications to the existing templates to tailor them to your preferences. There are a 

range of easy changes that can be made to the templates ranging from changing the text (by editing the HTML 

of the template) or the weather reading referenced (by changing the webtag), through to varying styling details 

such as font size, colours etc (by editing the styling CSS) or stock images that may be used. Each of these 

changes requires some elementary knowledge of for example HTML or CSS editing, but small changes may 

require only very basic alterations to the HTML or CSS code, which can be well within the capabilities of 

many users. 

There are also some complete and well executed third-party templates available for download. The Saratoga 

Weather templates are ones such source (saratoga-weather.org/wxtemplates/index.php# ). WeatherbyYou is 

another good source (www.weatherbyyou.com/demo.php ). In each case there are a number of different 

templates available, catering for different presentation scenarios – take a look and see if you like any of them. 

There will doubtless be further sources too – look or ask on the Cumulus forum. 

5.3.4 Creating Cumulus web pages from scratch 

It is entirely possible to create your own completely original design of weather webpages from scratch for use 

with Cumulus. The word ‘design’ here is the key one – you must, as a starting point, use the content items (i.e. 

the individual weather readings made available via Cumulus webtags) and image files that Cumulus uses. But 

you have full control over the fixed content (i.e. anything appearing on the webpage other the individual 

weather readings and any image files that you may be relying on Cumulus to generate); the way that all of the 

content is styled and formatted; and over any subsidiary functionality that you may decide to include on the 

webpage. 

So, a new design of webpage would be built up from the following elements: 

 The HTML of the webpage that defines all of the fixed content; 

 The individual weather readings are represented in the template HTML by the webtag placeholders – 

a comprehensive list of Cumulus webtags is available from: wiki.sandaysoft.com/a/Webtags ; 

 Any Cumulus-generated image files e.g. for trend graphs that you choose to use; 

 CSS styling of the webpage. (You obviously don’t have to use CSS, but the vast majority of modern 

webpage authors do prefer to use CSS to control styling and formatting); 

 And, as a more advanced option, some users have developed JavaScript routines that can be 

incorporated into webpage code to create derived weather values. So, for example, if there is a 

particular value or data presentation that is not available directly as a webtag, but which could be 

calculated from a webtag  that is available, then JavaScript functions could be used to achieve this; 

Remember also that Cumulus always generates the web pages that it uploads from its set of template files. So 

in creating your own webpage design, what you need to do in practice is to create your own template design. 

Templates, by default, are stored in the /web subfolder of Cumulus and named mytemplateT.htm which then 

becomes the webpage mytemplate.htm prior to FTP upload.  

http://saratoga-weather.org/wxtemplates/index.php
http://www.weatherbyyou.com/demo.php
http://wiki.sandaysoft.com/a/Webtags


06 June 2013 18 v0.2 

For anything other than minor changes to the standard templates, it’s probably a good idea to give your own 

templates a completely new name. You can then command Cumulus to process your own templates by 

making appropriate entries to the Configuration | Internet | Files tab, being sure to check the ‘Process’ box, to 

ensure that webtag processing is performed. Once, again, this procedure is quite a bit simpler than it may 

appear at first glance – more details are available in the wiki at wiki.sandaysoft.com/a/Customised_templates . 

 

http://wiki.sandaysoft.com/a/Customised_templates

